Innovative switching and control

LOGO! 8 in details part 2 of 3
Usage at the device and handling of the software

Unrestricted © Siemens AG 2016 siemens.com/logo
LOGO! in detail slides overview

The LOGO! in detail slides are split up in three different parts

- LOGO! in detail part 1
  - Installation and overview of the function blocks

- LOGO! in detail part 2
  - Usage at the device and handling of the software

- LOGO! in detail part 3
  - Tasks and features
Have you designed a circuit? Do you want to enter it into LOGO!?

How do you do this?

Connect LOGO! to the power supply and switch it on. The display now shows you this message.

Press **ESC** to get to the main menu.
Main menu / programming menu

Press ▲▼ to move the up and down. The selected point of the menu is always tagged by a bar.
Move it to “Program..” and confirm with OK.
LOGO! opens the programming menu.

In the next sub-menu please chose Edit Prog by moving with ▲▼ and confirm with OK.
You are now in programming menu.

Press ▲▼ to select all output, marker and open connectors.
Go to NEW for more function blocks.
1. You have to create your circuit by working from the output to the input.

2. You can connect an output to several inputs.

3. You can’t connect an output to an upstream input within the same path (recursion).
4. You can move with ▼ ▲ and ▼ ▲ . Use OK for editing the tagged item.
LOGO! - rules for operation

Close menus with **ESC**

Name of the block
If tagged, you can change it with **OK** and **↑ ↓ ← →**

Choose the an input block
If tagged, enter **OK** and choose with **↑ ↓ ← →**

Switching between the function blocks of the program
If tagged, switch with **OK**

Go to the connected block
If tagged, enter **OK**

Menu of the function block
If tagged, enter with **OK**

---

Type of the block

Message Text

<table>
<thead>
<tr>
<th>B1</th>
<th>Par</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>B2</th>
<th>1/3 +/-</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>= No</td>
</tr>
<tr>
<td>Msg Text</td>
<td>= ...</td>
</tr>
<tr>
<td>Priority</td>
<td>= 000</td>
</tr>
<tr>
<td>Tick Type</td>
<td>= C-C</td>
</tr>
<tr>
<td>Msg. Dst</td>
<td>= BM</td>
</tr>
</tbody>
</table>
Your first LOGO! program

Let us now take a look at the following parallel circuit consisting of two switches.

Circuit diagram

The load is switched on with S1 or S2.

Solution with LOGO!

LOGO! interprets the parallel circuit of S1 and S2 as an 'OR' logic, because S1 or S2 switches on the output.
S1 switches input I1, while S2 switches input I2. The load (E1) is connected to the relay Q1.

Let us now input the program (starting at the output and working towards the input). LOGO! initially shows the output Q1. You will see an underscore ( _ ) below the Q in Q1. It is called a cursor. The cursor indicates your current position in the program.
Program input

Now press the key **OK**. NEW is selected now. Press **OK** again.

Use **left** **right** to go to the input.

At this point you only enter the first block (the OR block).

Press **OK** to select editing mode.

Selected between the following by pressing **△ ▽** :
- Connectors → I, M, High, Low, C, F, S, Q
- Basic function (GF)
- Special function (SF)

Now press the key **OK**.

NEW is selected now. Press **OK** again.
Select with (GF) the basic functions and confirm with **OK**.

The **AND** is the first block of the basic functions (GF) list. You can choose between the following by pressing **△ ▽**:
- AND
- AND (edge)
- NAND
- NAND (edge)
- OR
- NOR
- XOR
- NOT

Select the OR block (≥1) and confirm with **OK**.
You have now entered the first block. Each new block is automatically assigned a block number (B1). Now you interconnect the block inputs (B1).

Press **OK**

You can choose between the following by pressing ▲▼:

- I, M, High, Low, C, F, S, Q
- Basic functions (GF)
- Special functions (SF)

The first element of the list is input I1 Confirm with **OK**. For editing the next input use ▲▼ and press **OK** again.
Now you connect input I2 to the input of the OR block.

1. Go to In2: Press ▲▼
2. Switch to editing mode: Press OK
3. The first element will be I1 again. Now you have to change the number separately from the element-type. Go to the Number: Press ▼▼▼
4. Set the number 2: Press ▲▼▼
5. Confirm I2 with OK

We do not need the last two inputs of the OR block for this program. You don’t need to do something more.
Now all block inputs are connected. For LOGO! the program is complete. We now exit program input mode and return to the programming menu with pushing \[\text{ESC}\] twice. Confirm the changes with “Yes”.

To start the program, return to the main menu with \[\text{ESC}\].

Move the cursor to “Start”: Press \[\triangle\ \boxdownarrow\]. To confirm press “Yes” with \[\text{OK}\].

Circuit program changed. Save changes?

Start program?

Now all block inputs are connected. For LOGO! the program is complete. We now exit program input mode and return to the programming menu with pushing \[\text{ESC}\] twice. Confirm the changes with “Yes”.

To start the program, return to the main menu with \[\text{ESC}\].

Move the cursor to “Start”: Press \[\triangle\ \boxdownarrow\]. To confirm press “Yes” with \[\text{OK}\].

Circuit program changed. Save changes?

Start program?

Now all block inputs are connected. For LOGO! the program is complete. We now exit program input mode and return to the programming menu with pushing \[\text{ESC}\] twice. Confirm the changes with “Yes”.

To start the program, return to the main menu with \[\text{ESC}\].

Move the cursor to “Start”: Press \[\triangle\ \boxdownarrow\]. To confirm press “Yes” with \[\text{OK}\].

Circuit program changed. Save changes?

Start program?
Selection of the starting screen after switching on the LOGO! (RUN mode) via LOGO! Soft Comfort possible.

**File ➔ Properties ➔ Power On**

**Let us have a look at our example:**

When switch S1 is closed, input I1 is supplied with voltage and the status at input I1 is “1”. LOGO! program calculates the status for the outputs. Output Q1 is “1”, in this case. When Q1 is “1”, LOGO! sets relay Q1, and the load connected to Q1 is supplied with voltage.
LOGO! parameterization mode

Parameterization of functions:
When speaking of parameterization, we refer to the configuration of functions.
You can configure the parameters
- in programming mode
- or
- in parameter assignment mode
You can configure:
- the delay times of timer functions
- the switching times of timer switch
- counter thresholds
- the monitoring interval for a hour counter
- on and off threshold for a trigger threshold
- and some other functions
To get to configuration mode press ESC in RUN mode, choose Program, set the cursor to Set Parameter and confirm with OK.
LOGO! parameterization mode

Block selection:
Choose In parameterization mode the desired block with △ ▽.
If the desired block is chosen, press OK. The cursor jumps to the first parameter that can be modified. The value can be changed pressing the arrow keys △ ▽.
If the desired value is configured, then press OK. The next blocks requiring modification, can be chosen with △ ▽ etc..
LOGO! parameterization mode

To return to RUN mode press **ESC** till the required display appears.
LOGO! ..0BA8 – Setting the language

In the LOGO! Menu you are able to change the menu language. The LOGO! has to be in STOP mode.

Available languages:
- EN – English
- IT – Italian
- NL – Dutch
- ES – Spanish
- FR – French
- CN – Chinese
- DE – German
- TR – Turkish
- RU – Russian
- JA – Japan

This setting can be separately done for LOGO! TD.
Backlight function for the basic modules:

To activate the backlight of the LOGO! display permanently, follow these steps.

You can select between:
- Default (Backlight is ON for 20 sec. / ON/OFF controlled by user program)
- Always On

This setting can be separately done for LOGO! TDE.

If the flags 25, 26, 28 – 31 are used for controlling the backlight the general setting is invalid.
LOGO! TD parameterization mode

In the menu of LOGO! TDE nearly the same menu items are available as at the LOGO! on-board menu including the possibility to edit the program.

The following table shows on which device which menu items are available:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>LOGO! Basic module</th>
<th>LOGO! TDE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>In STOP mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit program</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Card</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td>Setup</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>LCD Contrast / Backlight</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Menu language</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>2 or 4 AI used on basic module</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td>Start / Stop</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>In RUN mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Param</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Msg Config (e.g. Tick Time)</td>
<td>-</td>
<td>✓</td>
</tr>
</tbody>
</table>
LOGO! program creation on a PC with LOGO! Soft Comfort V8.1

Support for LOGO! TDE
- No separate software necessary

Modem wizard (only for LOGO! 6)
- for standard 11-bit analog modems

Windows Look and Feel
- e.g. context menu, toolbar

Create the control programs by „drag and drop“
- Control programs „drawing“ – directly on a PC in FBD or LAD

Testing of control programs
- Offline simulation with status for each function (color change)
- Online test with color change for each function and 30 actual values

Professional print and documentation functions

Device selection
- 0BA0, 0BA1, 0BA2, 0BA3, 0BA4, 0BA5, 0BA6, 0BA7, 0BA8 with function check

Network mode
- Adding other devices, e.g. HMI, S7-devices
- Simple connecting of function blocks between LOGO! devices
- **Additionally on the CD ROM:**
  - Manual and 28 complete example programs
  - LOGO! Access Tool
  - CAD drawing
Installing LOGO! Soft Comfort V8.1

1. Insert CD (LOGO! Soft Comfort V8.0) in CD-ROM drive
2. Display CD content with help of Explorer
3. Double click on start.html
Installing LOGO! Soft Comfort V8.1

Start.html functions

- Direct choice of 9 languages
- Software installation
- Direct start of software from CD-ROM
- Display manuals on CD-ROM
- Display online help
- Choice of example programs on CD-ROM
- Choice of CAD drawings on CD-ROM
- Installation of necessary tools such as Acrobat Reader or printer drivers
Installing LOGO! Soft Comfort V8.1

The USB cable driver for the LOGO! USB programming cable is also included on the CD-ROM. During the installation process you will be asked if you want to install the driver.

HINT: Follow the correct order!
1. Install the driver (administrator privileges are required!)
2. Then plug in the LOGO! USB programming cable
LOGO! Soft Comfort V8.1: Overview

- **Symbol bar for program installation**
- **Title bar**
- **Menu bar**
- **Text fields for additional comments**
- **Separate connections**
- **Drawing of connection lines**
- **Tree structure for fast choice of all function blocks**
- **Data Log**
- **Display special functions (SF)**
- **Display basic functions (GF)**
- **Display connectors (Co)**

**Standard Windows**

**Transfer Program**
- PC → LOGO!
- LOGO! → PC!

**Offline simulation**

**Online Test**

**Control program generation in the working area via drag & drop**
Help functions – Online help

With a mouse click on the desired topic you get detailed information about the corresponding functional group.

The general help can be activated via the menu item Help -> Content. You can find further information sorted by functional groups in the contents.
Direct help can be selected via the context menu (right mouse key) of each function.
Help functions – direct help

The direct help will also be activated via the menu item Help -> Context-sensitive Help. Via mouse pointer you can now select objects, you would like to have help text with.

Direct choice
You can install program updates, service packs and additional languages via the menu item Help -> Update Center.
Thank you for your attention!

DF FA S MP PLC 1
90475 Nuremberg

siemens.com/answers